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Chapter 1: Introduction

This document describes the New and Improved Features in v2022.4 for Avid S4 and S6 systems.

Throughout this and other documentation, S4 and S6 systems are referred to as “S4/S6.” S4/S6 system software is named
“Master Module software.” All features are available on both systems unless otherwise noted.

System Requirements and Compatibility

S4/S6 Master Module Software version 2022.4 requires the following:
» Valid S4/S6 license for Master Module software
« Avid Pro Tools® software 2022.4 or later
« Or other EUCON"-enabled applications (check with the manufacturer for compatibility information and requirements).
For a list of supported applications, system requirements, and other compatibility information, visit:
http://www.avid.com/products/pro-tools-s6/specifications
https://lwww.avid.com/products/avid-s4/compatible-software
DAW Compatibility In addition to Pro Tools, S4/S6 Software is compatible with the following (or later versions):
» Steinberg Nuendo 11 and Cubase 11 or later
» Apple Logic 10
* Magix Sequoia 14
* Merging Pyramix 8.x (Native only), and Pyramix 9.x
* Pro Tools | MTRX and MTRX Studio, ProMon (DADman), and NTP Technology AX32
» Avid XMON S6
WSControl Application Compatibility macOS 10.14 or higher (including macOS 10.14/’Mojave”, 10.15/”Catalina”, and 11.0 “Big

Sur” and “Monterey”) and Windows 10 or higher (including Windows 11). For the latest compatibility information, see
EUCON Compatibility.

macOS Privacy Settings On macOS 10.14/”Mojave” and later (including “Catalina”) you will be prompted to add applications
such as EuControl and Pro Tools to the Privacy list in System Preferences. If so, follow the on-screen instructions.

EUCON Development Partners For setup and configuration instructions for several applications from EUCON Development Part-
ners, see the EUCON Application Setup Guide.pdf, available for download from your Avid account. Please note that while these

applications are EUCON-enabled, the extent of integration with Avid control surfaces and supported software versions are at the
sole direction of the respective manufacturer. For details, please contact the manufacturer.
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Product Activation and Software License Activation

Activate your S4/S6 system software on-line as instructed later in this guide. You must use the System ID on the included
S$4/S6 System Software Activation Card to activate and download all S4/S6 system software and documentation. You will also need
to activate your software license after installing the software.

If you are upgrading a system, check your Avid account for the latest S4/S6 system software.

Software License Activation Information

After installing the new MasterModule software, you might be prompted to activate or update your software license. S6 software
licenses are valid for the entire year of the currently valid Support Contract.

In versions of S6 software prior to v3.5, a new license was required for each major release. All customers with current Support Con-
tracts who are upgrading from v2.2.1 or earlier must activate the new version by registering your System ID in order to transition
to the new yearly license system and download the latest software.

To receive your Activation ID, go to https://my.avid.com/products/Hardware/console and log into your Avid Account (or cre-
ate one). Follow the instructions on-screen to enter your System ID. For information about locating your System ID, see this article
on our Knowledge Base:

http://avid.force.com/pkb/articles/fag/How-to-find-S6-System-ID

Once the new version is activated, you will not need to activate a new license for any software updates that are released for the du-
ration of your current Support Contract. After you activate your license your Avid Account will be updated with the new S6 soft-
ware for you to download, and will also show your Support Contract dates.

About This Guide

This guide explains how to assemble your Avid S6 system.

Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key
Control-click Hold down the Control key and click the mouse button
Right-click Click with the right mouse button

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The names of switches and keys on the control surface are shown in bold (such as Select). In addition, the Shift switch on the
Master, Fader, or Joystick Module is always shown in bold to distinguish it from the Shift switch on the computer keyboard.

The following symbols are used to highlight important information:

Q User Tips are helpful hints for getting the most from your system.
A Important Notices include information that could affect your data or the performance of your system.
Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.
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How to Use this PDF Guide

These are some useful features of this PDF:
» The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page.
* Click a + symbol to expand that heading to show subheadings. Click the — symbol to collapse a subheading.

» The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns
into a finger, then click to locate to that subject and page.

» All cross references in blue are active links. Click to follow the reference.

+ Select Find from the Edit menu to search for a subject.

Resources

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system.
The following are just a few of the services and features available.

Account Activation, Product Registration, and License Activation

Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your
purchase online, download software, updates, documentation, and other resources. Activate your software license
https://lwww.avid.com/account

Support and Downloads

Contact Avid Customer Care (technical support); download software updates and the latest online manuals; browse the Compati-
bility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on the
User Conference.

https://www.avid.com/learn-and-support

For S4/S6 support, trouble-shooting, and downloads, visit:
Avid S4 and S6 Support

For user guides for S4, S6, and EuControl, visit:
EUCON Product Guides

For setup and configuration instructions for several applications from EUCON Development Partners, see the

EUCON Application Setup Guide.pdf.

Training and Education

Study on your own using courses available online or find out how you can learn in a classroom setting at an Avid-certified training

center.

Videos on YouTube

Check out the new Avid Pro Tools | S6 Workflows and original Get Started Fast with S6 video tutorials, available on YouTube.
Most of the videos are relevant to S4 as well as S6.

Products and Developers

Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and
hardware.
https://lwww.avid.com/Products/index.html

News and Events

Get the latest news from Avid or sign up for an S4/S6 demo.
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Chapter 2: New and Improved Features in v2022.4

Assignable Knob

The Assignable Knob can be assigned to almost any on-screen Pro Tools continuous control, including Clip Effects and AudioSuite
plug-ins, to be able to keep control over a given parameter regardless of window or controller focus. With the optional ability to

mirror the assignment to the Jog Wheel on the S4/S6 Master Module, the Assignable Knob also lets you adjust a parameter with

maximum resolution.

Note that while the Assignable Knob supports almost any continuous control parameter (and some switched controls) that can be
automated, not all parameters in all plug-ins from all manufacturers fully support the Assignable Knob. Knob assignment persists
in the current session only.

A Make sure all to update to the latest versions of all your plug-ins. While all Avid plug-ins support the Assignable Knob, at the time
of this writing not all third-party plug-ins do yet. If you find a plug-in that does not support the Assignable Knob contact the man-
ufacturer for more information.

On S4/S6, the Assignable Knob is located in the lower left corner of the Master Module.

To assign a parameter to the Assignable Knob:

1 Do the following:
* Pro Tools and Avid plug-ins: hover the cursor over the desired parameter or click directly on it.
 Third-party plug-ins: click the desired parameter.

On-screen in Pro Tools a blue highlight border appears around either the parameter being hovered over, or the currently as-
signed parameter (if any) as determined by the Pro Tools Preference for Display of Assignable Knob Control.

Q) ©)

pan Pan Knob

Hovering over a pan control in Pro Tools (shown at left) and blue highlighting (shown at right)

On the Master Module the Assignable Knob lights in the function color that corresponds to the hovered or currently assigned
parameter and its display shows the parameter name.

Assignable Knob controlling Pan, not locked

Chapter 2: New and Improved Features in v2022.4 5



2 Press the Assignable Knob to assign to lock it to the current parameter.

- Master Module

— Config —
< >

~ Automation Module

The Assignable Knob with pan assigned

3 Rotate the knob to adjust the assigned parameter, or press the Sel and In switches next to the Assignable Knob to increment and
decrement, respecitvely.

The parameter stays locked to the knob until you re-assign a different parameter, or close the session. The Assignable Knob has the
same Automation Indicator LEDs as other encoders.

Locking the Assignable Knob

By default, the Assignable Knob controls its assigned parameter for as long as you hover the mouse over that parameter. Lock a
parameter to the Assignable Knob so that you can maintain control of the assigned parameter regardless of where you navigate to
in Pro Tools. Unlock the Assignable Knob so that you can “soft assign” the knob to any parameter you hover over or click.

To lock or unlock the Assignable Knob:

= Press the Assignable Knob to toggle the Assignable Knob between locked or unlocked.

Adjusting the Assignable Knob Using the Automation Module Jog Wheel

You can use the Jog Wheel to adjust the current Assignable Knob parameter with greater resolution. Automation mode and Lock
status is indicated by LEDs surrounding the wheel.

To duplicate the Assignable Knob to the Jog Wheel:

1 With a parameter already assigned, press the Back switch below the Assignable Knob. The Jog Wheel now also controls the
assigned parameter.

Parameter value/position

Read LED Write LED
—— Config —
<« =]»
Back Lock LED

Enabling Wheel mode for the Assignable Knob (shown at left) and indicators in the wheel LED ring (shown lit, at right)

2 Rotate the wheel to adjust the parameter. LEDs light to indicate parameter value or position. When in automation Read mode
the Read LED lights green, when in a Write mode the Write LED lights red, and when locked the Lock LED lights in the same
function color as the Assignable Knob.
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Pro Tools Preference for Display of Assignable Knob Control

On-screen in Pro Tools a blue highlight border appears around either the parameter being hovered over, or the currently assigned
parameter (if any) as determined by the Pro Tools Preference setting Always Show EUCON Assignable Knob Highlight.

To optimize Assignable Knob indication:

1 In Pro Tools choose Setup > Preferences, and click the Mixing tab.

2 In the Controllers section, configure the Always Show EUCON Assignable Knob Highlight setting:

* When enabled, the Assignable Knob highlight is shown in Pro Tools whenever any parameter is hovered over, clicked, as-
signed, or adjusted.

* When not enabled, the Assignable Knob highlight is only shown around the currently assigned parameter (if any).

Q The blue highlight appears in Pro Tools whenever EUCON is enabled (Setup > Peripherals, Ethernet Controllers) even when
" using an Artist Mix or Artist Transport, which do not support the Assignable Knob.

Controllers.

+ Edit Window Follows Bank Selection
+/ Mix Window Follows Bank Selection
v *Scroll to Track" Banks Controllers
Always Fill Channel Strips when Banking
+ Always Show EUCON Assignable Knob Highlight

Touch Timeout: 000 msac
{non touch-sensitive controls)
EUCON Surfaces EQ Dyn cycling Starting at Insert: none

Assignable Knob setting in the Mixing tab of Setup > Preferences

Improved Recall of Multi-Workstation Layouts

Layout recall has been improved to better manage tracks in multi-workstation Layouts, especially those that include tracks from
other DAWs besides Pro Tools.

Tracks are stored in a Layout using a unique track ID (UID) to ensure tracks appear on the correct strips. If a Layout is recalled but
S4/S6 cannot match the track UID it will search for a matching track name, or (absolute) track number, and then by workstation.

By storing and matching track ID, name and/or number, and workstation you can create Layouts in session templates that will per-
sist in new sessions.

For maximum session and project compatibility, a new preference in Settings > System lets you enable “legacy” track matching
as available in 2021.10 and earlier. When the Use Legacy Layout Recall Matching setting is enabled, track matching will use UID,
track name, or (absolute) track number only. This setting is disabled by default.

Settings

ition &/ Spill Zone State

Auto-Load settings in Settings > System
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Soft Keys

The following new capabilities are now available for Soft Keys:
* Improved Pause/Delay

e 2022.4 Appset Enhancements

Improved Pause/Delay

When inserted between commands in the Soft Key Editor, the Pause command now applies a 25ms delay on both macOS and Win-
dows. Multiple Pause commands (25ms 25ms 25ms...) can be added for longer delays.

The Pause command can only be added after another keystroke, not before. For example, attempting to start a command with a
Pause is not supported (a dialog alerts you if you try to add a Pause in an unsupported location).

Q If a single Pause command does not work, try adding Pause commands (one at a time) until the macro has enough time to execute
©each command or action.

2022.4 Appset Enhancements

The following Quick Jump and commands have been added.

QuickJumps

Layouts and Memory Locations Access via Shift (Fader Module) + “-” (the round minus key to the left of the Automation Mod-
ule Jog Wheel). Lets you recall a Track Layout and a Memory Location / Marker with a single switch.

Layouts and Window Configurations Access via Shift (Fader Module) + “+” (the round + key to the right of the Automation
Module Jog Wheel. Lets you recall a Track Layout and a Window Configuration with a single switch. Window Configurations 1-24
(without Layouts) are also accessible

Control Room (via Extras) The Control Room switch in the Extras page (Automation Module right bank of Soft Keys, using the
default Pro Tools 2022.4 appset) provides links to access Mon A—D, to access sources, dim, and cut on the Master and Automation
Module Soft Keys.

Playlist and Workflow Soft Keys Access via Shift (Fader Module) + Zoom Horizontal (round key to the right of the Automation
Module Jog Wheel).

Commit Tracks Access via Shift (Fader Module) + Consol Clip (Automation Module Locate switches).
Trim Clip to Fill Selection Access via Shift (Fader Module) + Trim Sel (Automation Module Locate switches).
New Tracks Command (Fader Module) + “+” (Automation Module Numeric switches)

Delete Tracks Command (Fader Module) + "-" (Automation Module Numeric switches)

Chapter 2: New and Improved Features in v2022.4 8
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Chapter 3: Updating System and Workstation Software

The process for updating S4/S6 Master Module software and activating the required software license involves these steps:
» S4/S6 Software Activation
* Logging in as Administrator and Updating Master Module Software
» Activating Your Software License

¢ Installing Supporting Software

Q These instructions apply to customers with support contracts who are entitled to the latest software release. If you are configuring
" a new system for the first time, refer to the S4/S6 Guide.pdf for complete network and configuration instructions.

S4/S6 Software Activation

You must activate your S4/S6 to be able to download required Master Module software, as described below (and as described in
this article on our Knowledge Base: http://avid.force.com/pkb/articles/how_to/S6-Activation-Card).

1 (Required) Use the System ID on the included S4/S6 System Software Activation Card to activate your Avid account:

* Go to https://my.avid.com/products/Hardware/Console and log into your Avid y
Account (or create a new one, if necessary). AVI>

* Enter the System ID from the System Software Activation Card (shown at right) in-

cluded in the Master Module package. 5‘:5":3; ‘SD4C/ f::
Your System ID can be found on the S4/S6 System Sofiware Activation Card included in
the front pouch of the S4/S6 Installation Guide. Activating deposits your software Acti- O e O
vation ID number into your account, which you will use later to acquire your software li- |
cense, as well as software downloads and documentation. p
Avid® S4/56

2 (Required) Acquire your Software License. vSTEM b CanD

» Make sure you are still logged into your Avid Master Account at l_ﬂ"’lﬂmmﬂflﬂmlﬂllﬂlﬂﬂmmlﬂm
https://my.avid.com. * 1000000 *

For instructions, visit www.avid.com/activationcard

+ Retrieve your Activation ID number (My Products and Subscriptions > Avid S6 D s e rac ety "
M40/M10 Software and Support or Avid S4 Software and Support). | pomeainusa 70207150800 4

* You will use this number later to activate your new software license.

» Navigate to the My Products and Subscriptions page where software updates, Workstation software, documentation, and
other resources are available. Download the latest versions of the S4/S6 Master Module Software, Workstation software (Mac
or Windows), and documentation from your Avid account to your computer.

* Insert a USB flash drive into an available USB port on your computer.
A Do not use the System Restore USB drive! Use a separate USB flash drive.

* If necessary, extract (decompress) the .ZIP file containing the Master Module software to unzip it.

» Copy the resulting file (.exe) to the top (root) level of your USB drive, then remove (eject) the USB drive.
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Logging in as Administrator and Updating Master Module Software
To install and update Master Module software:

1 If you have not already done so, navigate the touchscreen to the Settings > About page and press Logout.

2 Select Administrator. When prompted enter the following default password: password

3 Click the File Explorer tile.

4 Plug the USB flash drive with the downloaded S6 Master Module installer into one of the available USB ports on the back of
the Master Module. The USB drive appears in the left hand column under Computer.

5 Tap on the USB flash drive to see the contents.

6 Launch (run) the S4S6MasterModulelnstall software from the flash drive by double-tapping on the icon.
Follow the instructions on-screen. After the installer has completed you will be prompted to restart the system.

7 Tap Yes to restart the system immediately.
« If after restarting the Software License Activation screen appears, proceed to Activating Your Software License.

» Ifnot, proceed to Installing Supporting Software.

Activating Your Software License

Master Module software is licensed and must be activated if prompted to do so after installation. If the Software License Activation
screen appears, do the following to perform an Offline Activation.

Offline activation requires a separate computer and USB flash drive. You can use the same USB flash drive on which you copied
the S6MasterModulelnstall software.

A Do not use the System Restore USB drive! Use a separate USB flash drive.

About Online Activation Online Activation should only be performed while in direct contact with Avid Customer Support.

Offline Activation

Make sure you have the System ID number and software Activation ID, and also make sure you have installed the new software
and restarted your system.

To activate S6 software using offline activation:

1 After the system has restarted, the Software License Activation screen appears. Help text appears in the lower half of the screen.

Software License Activation

License needs to be activated.

Activation type: Offline

Device ID:  Your Device |D Appears Here

Figure 1. S6 Software License Activation screen for offline activation

2 Make sure Offline is selected for the Activation Type. If not, tap the selector and choose Offline.
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3 On a separate internet-connected computer go to http://www.avid.com/license to see the Software License Activation page.

SOFTWARE LICENSE ACTIVATION

ACTIVATE YOUR AVID SOFTWARE PRODUCTS OR ACTIVATE OPTIONAL
OPTIONAL FEATURE. FEATURES

Please enter the following information. * Required

Activation ID*
Device D+
Email Address

Email is an optional field, however we recommend you provide an

email so we can also send you the software license file.
connee

Figure 2. Software License Activation page

4 Enter the following information, making sure to enter all characters and numbers correctly (fields are not case-sensitive):

» Enter your Activation ID into the Activation ID field. Once entered, a System ID field appears. Press Tab to go to the next
field.

* Enter your System ID into the System ID field. Press Tab to go to the next field.
 Enter your Device ID (shown on the S6 Software License Activation screen) into the Device ID field.

When a valid ID number is entered into each field, a green check mark appears. If any characters are incorrect, and until the cor-
rect number of characters has been entered, an error message appears.

* (Optional) Enter the email address associated with your Avid account to receive an email with a copy of your license file.
5 Click Submit, then follow the instructions on-screen to do the following:
» Download the license file (.bin) to your computer, then transfer the license file to a USB flash drive.

A Do not use the System Restore drive. Use a separate USB flash drive (not included), formatted as FAT or FAT32.

» Remove the USB drive from your computer, then insert it into one of the USB ports on the back of the Master Module.
6 On the Master Module touchscreen, tap Activate. A standard Windows Open dialog appears.

7 Navigate the dialog to the USB drive, select the downloaded license file (“S6xxx.bin”’) and tap Open.

After a few moments your software will be activated.
8 After activating your software, if you are prompted to update module firmware after the system restarts do the following:

» Navigate to the Settings > Surface page and press Update.

Q If no Update option is displayed either the system hasn't completely booted yet, or a module is selected on that screen. Wait for
" the system to finish starting up, and be sure no module is selected on-screen (indicated by a lit rectangle surrounding that module).

* When prompted, confirm the update and then wait until all modules have updated (which can take several minutes). Do not
turn off any modules during this process. The screen displays a message confirming that the update has completed.

9 Proceed to Installing Supporting Software.
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Installing Supporting Software

Your Avid Master Account also provides workstation software for Windows and Mac, and documentation. XMON EUCON soft-
ware is also included in these installers. Whenever you update S4/S6 system software you must also update workstation software
on all connected workstations.

Q EUCON installs into a default directory for all EUCON devices (including the Control app, Dock, S3, and S6). This lets you co-in-
° stall all software for these devices.

After updating S4/S6 system software, do the following:

1 Login to your Avid Master Account and download EUCON_WorkstationUnifiedInstall software for your workstation (Mac or
Windows), documentation, and other resources from the My Products and Subscriptions section.

Q You can download these components directly to the workstation(s) you plan to use with S4, or to a USB flash drive.

2 Ifnecessary, insert the USB drive containing the downloaded EUCON_WorkstationUnifiedInstall into a USB port on your
workstation.

A Do not use the included System Restore USB drive! Use a separate USB flash drive.

To install WSControl (workstation) software:

1 Double-click EUCON_WorkstationUnifiedInstall, then double-click the installer to launch it.

2 Follow the instructions on-screen (select each option you want to install):
« To install Workstation software for S4 and S6, click to select S6 / S4 Workstation.

d Install EUCON'\'f\Vlorkstat'i'cn Unmed

Custom Install on “Macintosh HD"

Package Name
troduction $1/53 / Dock / Control / Artist Serles
License | ¥ 5456 Workstation
Avid Control Desktop
XMon
instaliation 7ype External Workstation
Uninstall all applications

Destination Select

Space Required: 105.5 MB Remaining: 489.73 GB
Install S4 / S6 Workstation Software (WSControlApp).

Unchecked items will be uninstalled.

Go Back Continue

Installing S4/S6 Workstation software

 Ifyou will be using S4/S6 and the Control app simultaneously, select both S1/S3/Dock/Control/Artist Series and S4/S6
Workstation. (Other combinations are allowed (such as S4/S6 Workstation and External Workstation software) but once in-
stalled cannot be run simultaneously.)

3 After installation is complete you can configure Workstation Control (aka WSControl) software to auto-launch by clicking the
WSControl icon in the Tool bar (Mac) or system tray (Windows) and selecting WSControl from the Auto Launch sub-menu).

To uninstall items:
1 Launch the installer.

Items that are currently installed are selected (checked) and indicated as Installed.
2 Do the following:

» To uninstall a specific component, make sure it is not selected (no check mark).

» To uninstall all EUCON applications, select Uninstall all applications.

» To uninstall all User Preferences, select Uninstall User Preferences (your appsets will not be removed).

3 Click Continue (Mac) or Next (Windows).
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Chapter 5: Release Notes

For Avid S4/S6 Systems
» For information about what has been fixed, see What is Fixed in EUCON 2022.4.

» For information about issues that may affect system performance, see Known Issues.

Software Installation and License Activation Information

S4/S6 Master Module software requires a valid license. If after installing Master Module software you are prompted to Activate,
follow the instructions on-screen to activate your software license (see also Activating Your Software License).

Important — Shutting Down the System

Whenever you need to manually shut down the system, always follow these steps.

To shut down the system:

1 Shut down the Master Module first. (Navigate the Touchscreen to Settings > About page, then touch Shut Down. Wait for the
Master Module to completely shut down.)

A Always shut down the Master Module before powering down the system!

2 Power off the S4, or turn off power at the source device supplying power to S6 Power Strip (UPS, power conditioner or other
source).

Restoring the System If you ever need to perform a System Restore, be sure to power cycle the entire system after the System Re-
store is completed.

What is Fixed in EUCON 2022.4

* It was possible for fader focus to incorrectly remain on DADman Sources instead of Pro Tools tracks, while some Sources and
tracks have identical names (GWSW-15561)

+ It was possible for S4/S6 controls to fail to update correctly after some complex actions such as rapidly recalling Layouts with
Swap layers, or rapidly switching between Swap layers (GWSW-15779)

It was downright likely that Soft Keys which included combinations of Surface commands and EUCON commands could be-
come unresponsive (GWSW-15757)

It was possible for the Master Module touchscreen to fail to display non-English characters (GWSW-15695)

+ It was possible for Soft Keys that included macOS modifiers (such as Command + Shift + P, to toggle QuickPunch) could leave
that modifier key “stuck” and apply it to the next action (GWSW-15686)

*  When using “Double tap to assign” to create a new Layout under certain workstation and track conditions, the new Layout could
fail to clear any unused strips (GWSW-15578)

It was possible for meters and Attention Expand Faders to get out of sync after enabling Banking mode or recalling Layouts
(GWSW-15557)
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Issues Resolved in Previous Versions of $S4/S6 Software

The following issues were resolved in previous versions of Master Module software for Avid S4 and S6.

What Was Fixed in EUCON 2021.10
+ It was possible for S4/S6 to lose the ability to select or assign some DADman monitor sources (GWSW-12129)

* VCA Spill could take a long time (GWSW-15346)

It was possible to become unable to toggle between Layout and Banking modes while Show Hidden Tracks in Layout Mode
was disabled (GWSW-15487)

* The Function scroller could fail to correctly indicate the bypass state of inserts (GWSW-15460)

*  When the preference for Auto Expand Faders was enabled and All mode was enabled while a function was already expanded,
pressing the active Expand key could incorrectly enable Expand for all strips instead of collapsing the currently expanded func-
tion (GWSW-15527)

It was possible for the MTM app to crash when closing (GWSW-15542)

+ If the Master Module was restarted while connected to a workstation and Attention Expand Knob Modules were OFF, Display
Modules could get stuck in an incorrect state (GWSW-15529)

*  When using the Master Joystick Module, it was possible for Shift + Y to fail to access Height (GWSW-15316)
* When using S4/S6 with Apple Logic Pro, it was possible for inserts to be displayed incorrectly (GWSW-15356)

What Was Fixed in EUCON 2021.6.1
« It was possible for S4/S6 session data to be reloaded to the surface during unrelated operations (GWSW-15328)

What Was Fixed in S$S4/S6 2021.6

It was possible for the Fader Module Automation indicator to fail to distinguish between Trim and Absolute mode indication
(GWSW-14899)

+ It was possible for knobs to retain their previous assignments when focus was switched between different DAWs on the same
workstation (GWSW-14882)

+ Attention Expand knobs could fail to update on first attention when different workstations were spilled to Spill Zones
(GWSW-14636)

It was possible for the Post Assign screen to fail to show all elements, particularly after reconfiguring Master Post Modules or
linked Display Modules (GWSW-14843)

+ In the Metering > Assign screen, it was possible for the Insert function to replace instead of inserting (GWSW-14777)
+ In the Layouts > Assign screen, it was possible for Delete strip to function incorrectly (GWSW-14751)

» If the Master Module was restarted while connected, it was possible Pro Tools on macOS (only) to fail to reconnected
(GWSW-14160)

+ CDM Attention Expand knob views could fail to update (GWSW-13450)
* It was possible for an export of the Surface Arrangement to fail (Universal Master Modules only) (GWSW-15223
* In Steinberg Nuendo, it was possible for not all VSTi controls to appear on strips (GWSW-15180)

What was Fixed in EUCON 2020.11.1

S4/S6
* The MTM app installer failed to update correctly (RELENG-3467)
» Dedicated Attention expand Knob Modules could turn off when Attention Expand Knob Modules were enabled (GWSW-14052)

» When spilling Folder Tracks that contained Child or Sibling Folders to a spill zone, it was possible for some Folder Tracks to re-
main open (GWSW-14677)
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Avid Control

» While focused on EQ Function, adding an EQ while ChannelStrip was the default EQ could switch the app to Dyn function
(GWSW-14645)

* It was possible for Pro Tools to incorrectly show Avid Control visible tracks after reconnecting Avid Control (GWSW-14609)

 After bypassing EQ and then re-attentioning a track, it was possible for the In key LED for Channel Strip plug-in to remain lit
(GWSW-14671)

Avid S1 and Artist Mix

+ Steinberg Nuendo and Cubase can now access Quick Controls and Filter from the S1 or Artist Mix surface:

Accessing Quick Controls and Filer

Function

Quick Controls Press and hold Aux/Group

Filter Press and hold Pan/Mix
Avid S3

(731}

After using changing the selection in Pro Tools, such as using the “;” shortcut, it was possible for the S3 In key LED to become unlit
(GWSW-14670)

+ It was possible for waveforms to fail to display consistently on Display Modules (GWSW-14027)
It was possible for meters to fail to draw when toggling Attention Expand Faders (GWSW-12365)

EUCON Development Partner Applications
It was possible for values to jump to default when touched while Open Windows on Knob Touch was enabled (GWSW-14103)
 Digital Performer: It was possible for MIDI track faders to fail to function (GWSW-12484)

What Was New and Fixed in $4/S6 20.6.1
EUCON 20.6.1 was a patch release for EuControl/EUCON Workstation and S4/S6 Master Module software to provide the follow-
ing fixes:

» When assigning tracks to Layouts from the Avid Control app while the Pro Tools session included hidden tracks or tracks within
closed Folder Tracks, it was possible for incorrect tracks to appear in the Layout (GWSW-14182)

+ Avid Control: Layouts could appear blank after focusing another application and then back to Pro Tools (GWSW-14211)

What Was New and Fixed in $4/S6 20.6

* The appsets for Pro Tools 12 (macOS and Windows) would display default snapshot names instead of custom names
(GWSW-14129)

* When using the Avid Control app and EuControl simultaneously with S4/S6, it was possible for the Monitor Lock setting (Eu-
Control Settings > Assign tab) to be unavailable (GWSW-14126)

What Was New and Fixed in $4/S6 20.5
+ It was possible to place a track into Write mode when cycling through Automation modes (GWSW-13650)

It was possible for all tracks to be incorrectly assigned to the same automation mode when using Option + M on a Fader Module
(GWSW-13695)

*  When the same tracks were present on multiple MPMs (mirror mode) it was possible that the link states would not recall cor-
rectly in MPM layouts (GWSW-13447)

* The Master Module could intermittently freeze during EUCON Object Mapping when a Pro Tools session was opened or when
new Session Data was imported (GWSW-13222)

It was possible for duplicated tracks to fail to display identical data (GWSW-13039)
It was possible for multi-DAW Soft Keys (such as Preview) to eventually fall out of display sync (GWSW-12624)

+ It was possible for the MPM Link light to become stuck on when the track on the MPM was removed unexpectedly
(GWSW-11929)
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* It was possible for waveforms to display incompletely on initial connection (GWSW-13374)
* Enabling or disabling Attention Expand knobs and faders could fail to update correctly (GWSW-13724)
* S4: The CSM Expand switch LED could fail to light when Auto Expand was enabled for Inserts Selection (GWSW-13728)

What Was New and Fixed in $4/S6 20.1
» Automation LEDs could continue flashing, incorrectly indicating a Write mode (GWSW-13649)
* S4: Function Select LEDs on Channel Strip Modules could stay on after another function was selected (GWSW-13645)

* S4: It was possible for Function LEDs on the Channel Strip Module to fail to indicate the current function while All mode was
active (GWSW-13651)

* A restart of the MTMapp could be required after modifying the Attention Expand Knobs arrangement (GWSW-13453)

» When creating an Expand Fader map, or when Expand Faders were active, unused strips that should be blank could continue to
display data (GWSW-13648)

Switch Labels for Reassigned Default Soft Keys

If you own an Automation Module with original text on Locate switches (Trim +, Trim -, Store Current, Store Locate, Edit, Re-
call, Delete, Clear) and you would like a set of 8 stickers with the new text (Mix/Edit, Faders Off, Trim Sel, Consol Clip, Edit
Loc, Undo, Redo, Save) visit http://www.avid.com/S6stickers and fill out the brief form with your contact and shipping in-
formation.

Known Issues

The following are known issues you may encounter using S4/S6, along with workarounds if they exist.

* Downgrading from 3.6 to 3.5 (GWSW-10593)
If you uninstall S6 v3.6 and then install v3.5, startup can hang at “Loading Surface Preferences.”
Workaround: Delete, rename or move the S6 Monitor Settings file, located at C:\ProgramData\Avid\S6\MonitorSettings. (By
default, ProgramData is a hidden directory. To access it, open the View tab and enable Hidden items from the View tab.)

» Workstation Sleep causes problems with connectivity and performance
If workstations enter Sleep mode, communication and performance can be problematic until S6 and all workstations are
power-cycled.
Workaround: Set all connected workstations to never sleep.

* S6 does not update the displayed setting for Solo switch (Intercancel versus Sum) after changing the Solo switch mode in
Pro Tools (GWSW-8214)
Changing the Solo switch mode in Pro Tools does not always update the displayed state of Solo on S6. Switch behavior correctly
follows the selected mode on the specific workstation on which it was configured, it is only the displayed setting on S6 that does
not update.

Layouts

3rd Party EUCON applications only: Newly added Tracks can be lost from Layouts after disconnecting a workstation or
changing the designated Layout Store workstation before closing a session (GWSW-9334)

This component of GWSW-9334 affects 3rd party (non-Pro Tools) EUCON applications only. If you add one or more tracks to a
Layout and then disconnect the designated workstation before saving the session/project, those recently added tracks may not be
recalled when the workstation is reconnected and that session/project is reopened.

Workaround: Close and save the session before either disconnecting its workstation, or designating a different Layout Store
workstation. If you do disconnect while a session is open, don’t save it until after you have reconnected the workstation to S6.

After using Import Session Data (Pro Tools), S6 Layouts fail to recall stored knob assignments (GWSW-9285)
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Monitoring

Monitoring page inactive unless Monitoring application Is focused

The S6 Monitoring page does not show sources unless the monitoring application (such as XMON EUCON) is focused on the
workstation, even if the S6 Monitoring section is locked to the monitoring application.

XMON: Audio passes through even when no sources are selected on first launch after installation (GWSW-7169)
Workaround: Select your Source from the XMON application, quit and relaunch.

DADMan: Source selection Sum and Intercancel mode setting conflicts with S6 Monitoring mode setting (GWSW-9640)

The S6 Monitoring local options page lets you configure Source selection for Sum or Intercancel mode, and this setting can conflict
with the same settings available in DADMan preferences.

Workaround: Do either of the following:

 In the S6 Monitoring local options, set Source selection to Sum mode and then only use DADMan preferences to switch
modes.

» Configure DADMan preferences to Sum and only use S6 to switch modes.

Master Joystick Module

When using the Master Joystick Module to pan a stereo track with Stereo Link enabled, touching both joysticks
simultaneously can lock up the pan position of one side of the stereo signal when only one joystick is released
(GWSW-9080)

Workaround: Let go of both joysticks then touch or move either to re-establish stereo linked panning.
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Technical Support (USA) Product Information
Visit the Online Support Center For company and product informa-
at www.avid.com/support tion, visit us on the web at www.av-

id.com
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